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Introduction
 

learning of computer applications covering basic concepts and in-detail insight into the software 
applications and programming approach. The series incorporates interactive, interesting and 
hands on methodology. Through class 1 to 8, the series covers features of MS-Office 2019/16 
over Windows 10. It also includes many futuristic applications and concepts like Tux Paint, 
GIMP, Flash, Photoshop, CSS, App development, JavaScript, Data Science, Artificial Intelligence  
and Python etc.

IT VOLTE

IT VOLTE, a series of 8 books, is a humble effort to provide futuristic and comprehensive

https://www.eduitspl.com/teachers-corner/class-i-viii/
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EDUSOFT AS YOUR TEACHING-LEARNING PARTNER
Dear reader,

Our association does not end with this book in your hands. Quite fairly, it begins! No matter if you are 
a teacher or a student, our support for the teaching-learning goes throughout the session. Being in the 
learning business we know that learning is an on-going, never-stopping process and learning is something 
which must be pursued and practiced together.

Team Edusoft offers many means to add fun and excitement to your teaching-learning.

TEACHER’S CORNER
This is for teachers, of course. Please do register in the 
Teacher’s Corner at www.eduitspl.com. This interface 
provides you additional teaching-learning aids in 
the form of worksheets, reference material, sample 
question papers and other such tools to enrich your 
teaching approach.

EDUSOFT KNOWLEDGEVERSE
Visit the YouTube channel KNOWLEDGEVERSE 
which offers exciting videos on a variety of topics 
which you may find useful for your ongoing learning. 
These videos can be used for various purposes - 
learning quickly, revision, learning coding, learning 
more about various software and concepts of IT, 
knowing about best practices of teaching-learning 
etc.

ACADEMIC AND SKILL ACTIVITIES
During the session, we conduct webinars, activities, contests and interactions that help you grow as 
learner and a teacher. This keeps us in touch to understand your changing needs better and to serve you 
in an improved way. 

We are constantly striving in making your teaching-learning experience better and exciting in our own 
unique ways and will keep you updated on all the futuristic developments we are doing in this regard.

Please visit the following links that offer plentiful academic reference material useful for you: 

l	 150+ eBooks available at www.eduitspl.com/ebooks  

l	 500+ eContent videos available at www.youtube.com/edusoftknowledgeverse 

l	 List of eContent videos (sorted class & topic wise) available at www.eduitspl.com/YLS 

l	 Test Generator & Teacher Manuals available at www.eduitspl.com/teachers-corner-2
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Class 1

TERM - I
1.	 Computer: A Digital Machine

2.	 Parts of a Computer

3.	 Computer Etiquette

TERM – II
4.	 Taming the Mouse

5.	 The Keyboard

6.	 Drawing with Computers

Exercises

Chapter 1 – Computer: A Digital Machine

A.	 Choose the correct answer.
1. a	 2. a	 3. b	 4. d		  5. b	

B.	 Tick () the correct statement and cross (x) out the wrong one.
1. True ()	 2. False (x)	 3. True ()	 4. False (x)	 5. True ()

C.	 Fill in the blanks.
1. Machine	 2. Sharpener	 3. Electricity         4. Laptop          5. Personal	

D.	 Match the following:
Column-I		  Column-II
1.	 -	 b
2.	 -	 d
3.	 -	 a
4.	 -	 c

E.	 Complete the places where we see computers:

1. SCHOOL	 2. BANK	 3. SHOPPING MALL	 4. AIRPORT	

Chapter 2 – Parts of a Computer

A.	 Choose the correct answer.

1. a	  2. c	 3. d	 4. a

B.	 Fill in the blanks.
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1. Monitor	 2. Keyboard	 3. Mouse	 4. Headphone	 5. Typing

C.	 Complete the following words with correct letters.
1. MOUSE	 2. MONITOR	 3. PRINTER	 4. KEYBOARD

D.	 Match the following.
1. d	 2. a	 3. e	 4. f	 5. c	 6. b

Chapter 3 – Computer Etiquette

A.	 Choose the correct answer.
1. b	 2. d	 3. d	 4. d	 5. a

B.	 Tick () the correct statement and cross (x) out the wrong one.
1. True ()	 2. False (x)	 3. True ()	 4. True ()	 5. False (x)	

6. False (x)

Chapter 4 – Taming the Mouse

A.	 Choose the correct answer.
1. d	 2. b	 3. d	 4. d	 5. b

B.	 Fill in the blanks.
1. Scroll wheel	  2. Tail	 3. Mouse pad	 4. Right-click	 5. Pointer

C.	 Write the missing letters to complete the words.
1. MOUSE	 2. DOUBLE-CLICK	 3. RIGHT-CLICK	 4. DRAGGING	 5. SCROLL-WHEEL

D.	 Tick () the correct statement and cross (x) out the wrong one.
1. False (x)	 2. True ()	 3. True ()	 4. False (x)	 5. True ()

E.	 Match the following columns.
1	 -	 c
2	 -	 d
3	 -	 b
4	 -	 a	

Chapter 5 -The Keyboard

A.	 Choose the correct answer.
1. d	 2. a	 3. d	 4. c	 5. a	 6. d

B.	 Fill in the letters to make the name of various keys on the keyboard:
1. NUMERIC KEYS		  2. ALPHABETIC KEYS	 3. ENTER KEY	
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4. SPACEBAR			   5. ARROW KEYS

C.	 Fill in the blanks.
1. Alphabet	 2. Delete	 3. Enter	 4. Spacebar	 5. Up Arrow	
6. Number

D.	 Match the following.

	

Chapter 6 - Drawing with Computers
A.	 Choose the correct answer.

1. d	 2. b	 3. b	 4. a	 5. d

B.	 Fill in the blanks.
1. Line	 2. Fill with Color	 3. Oval	 4. Size	 5. Shapes	 6. Drawing area

C.	 Name the different parts of a paint window.
	

D.	 Rearrange the steps for opening paint in correct order.
1.	 Click on the Start menu.
2.	 Click on Windows Accessories.
3.	 Click on Paint.
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Class 2

SYLLABUS
TERM - I

1.	 Parts of a Computer

2.	 Computers are Everywhere

3.	 Working with Computer

TERM – II
4.	 Introduction to WordPad

5	 WordPad: Formatting

6.	 Painting with Tux Paint

7.	 MS Paint: Drawing with Shapes

Exercises

Chapter 1 – Parts of a Computer
A.	 Choose the correct answer.

1. c	 2. b	 3. c	 4. a
B.	 Fill in the blanks.

1. Monitor	 2. Keyboard	 3. Mouse	 4. Web camera	 5. Headphone
C.	 Complete the names of the following parts of a computer.

1. HEADPHONE	   2. PRINTER	 3. WEBCAMERA	 4. JOYSTICK	 5. SPEAKER
D.	 Help your friends by writing the correct part of the computer.

1. Printer	 2. Headphone	 3. Monitor & Joystick	 4. Web camera	 5. Mouse
6. Keyboard	 7. Monitor (and/or speakers or headphones, if student writes only Monitor, 
	     give full marks)

Chapter 2 – Computers are Everywhere

A.	 Choose the correct answer.
	 1. d	 2. a	 3. c	 4. b	 5. d
B.	 Fill in the blanks.

1. Electronic	 2. Teaching	 3. Booking Tickets	 4. Calls	
5. Computer 	   6. Laptop
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C.	 Rewrite jumble words.
1. TABLET	 2. LAPTOP	 3. DESKTOP	 4. COMPUTER	 5. SMARTPHONE

D.	 Write any two uses of a computer at the following places.
1.	 School:	 i.	 For teaching the students (using smart boards).
		  ii.	 Keeping the books’ record in a library.
2.	 Hospital:	 i.	 For keeping the record of the patients.
		  ii.	 To diagnose the diseases and check patient’s records.
3.	 Bank:	 i.	 For maintaining the accounts of the customers.
		  ii.	 To manage the transactions done by the customers.
4.	 Railway Station:	 i.	 For booking and cancellation of the tickets.
		  ii.	 For tracking the arrival and departure of the tickets.
5.	 Hotel:	 i.	 To record the guest details.
		  i.	 To book the rooms and to make the bills.

Chapter 3 – Working with Computer
A.	 Choose the correct answer.

1. d	 2. a	 3. a	 4. d	 5. b
B.	 Fill in the blanks.

1. Operating system	 2. Window	 3. Taskbar	 4. Wallpaper	 5. Icons
C.	 Match the following.

1. c	 2. a	 3. b	 4. e	 5. d
D.	 Answer the following questions.

1.	 The process to start a computer is called booting.
2.	 Operating system is a software that helps us to operate the computer.
3.	 The components of Taskbar are Start button, Quick Launch toolbar, Middle section and System 

tray.
4.	 MS Windows is an operating system from Microsoft.

Chapter 4 – Introduction to WordPad
A.	 Choose the correct answer.

1. b	 2. d	 3. d	 4. a	 5. d
B.	 Fill in the blanks.

1. Cursor	 2. Open	 3. File menu	 4. Ruler	 5. Save
C.	 Match the following.

1. e	 2. d	 3. b	 4. a	 5. c
D.	 Answer the following questions.

1.	 WordPad is a program for typing letters, stories, etc.
2.	 WordPad button, Ribbon, Work Area, Ruler, Zoom in and out.
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3.	 Zoom In is used to enlarge the document view while, Zoom Out is used to reduce the document view.
4.	 Ruler: A Ruler is used to set the width and view of a document. 
	 Work area: It is the white space in the window to type text. 
	 Cursor: It is the small vertical blinking line in the work area.

Chapter 5 – WordPad: Formatting
A.	 Choose the correct answer.

1. d	 2. d	 3.a	 4. d	 5. d
B.	 Tick () the correct statement and cross (x) out the wrong one.

1. False (×)	 2. True ()	 3. False (×)	 4. True ()	 5. True ()
C.	 Answer the following questions.

1.	 Changing the font, face, colour, size of text is called formatting.
2.	 Font style is applied to make text bold, italic and underlined.

D.	 Match the following.
1. d	 2. c	    3. b	         4. a

Chapter 6 – Painting with Tux Paint
A.	 Choose the correct answer.

1. b	 2. a	 3. d	 4. a	 5. c
B.	 Fill in the blanks.

1. Lines	 2. Eraser	 3. Shapes	 4. Paint	 5. Quit
C.	 Match the following.
	

D.	 Answer the following questions.
1.	 Different parts of Tux Paint window are Toolbar, Selector, Drawing canvas, Colors Box are Help Area.
2.	 Square, Rectangle, Circle and Ellipse.
3.	 i.	 Click on the Start button.
	 ii.	 Click on the Tux Paint folder.
	 iii.	 Choose Tux Paint (full screen/window) option.
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Chapter 7 – MS Paint: Drawing with Shapes
A.	 Choose the correct answer.

1. b	 2. a	 3. a	 4. a	 5. c
B.	 Write the correct name of the tool or option given here.

1. Size	 2. Outline or Fill	 3. Shapes	 4. Colors
C.	 Fill in the blanks.

1. Color 1	 2. Fill	 3. Shift	 4. Fill with Color	 5. Color 2
D.	 Answer the following questions.

1.	 Shapes tool has various shapes such as arrows, stars and call outs.
2.	 Fill with Color tool helps us to fill colours inside a shape.
3.	 Arrows, Stars and Call outs.
4.	 Home tab > Tools group > Fill with Color tool > Select Color 1 > Select desired colour > Click 

inside the shape.
5.	 4 > 2 > 1 > 5 > 3

Class 3

SYLLABUS
TERM - I

1.	 Introduction to Windows GUI

2.	 Tux Paint: Advanced

3.	 Advanced MS Paint	

4.	 Know Your Computer

Term - II
5.	 Fun with Logo

6.	 More on MSW Logo

7.	 Introduction to MS Word 

8.	 Stepwise Thinking with Scratch

Exercises

Chapter 1 – Introduction to Windows GUI 
A.	 Choose the correct answer.

1. a	 2. c	 3. a	 4. c	 5. a
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B.	 Fill in the blanks.
1. Desktop	 2. Interface	 3. Accessories	 4. Workspace	 5. Gadget

C.	 Match the following.
1. d	 2. a	 3. b	 4. e	 5. c

D.	 Answer the following questions. 
1.	 Windows 10 is a popular operating system from Microsoft.
2.	 The small pictures on the screen are called the icons.
3.	 Taskbar is a horizontal bar at the bottom of the desktop. It contains Start button and System tray etc.
4.	 Four Windows 10 accessories are Notepad, Wordpad, Paint and Calculator. 

Chapter 2 – Tux Paint: Advanced
A.	 Choose the correct answer.

1. a	 2. a	 3. d	 4. b	 5. a	 6. d
B.	 Fill in the blanks.

1. Magic	 2. Erase button	 3. Undo tool	 4. Print button	 5. Slide
C.	 Mark() on the correct statement and cross (x) on the incorrect statement.

1. True ()	 2. False (×)	 3. False (×)	 4. False (×)	 5. True ()
D.	 Name the tool for doing the following actions.

  1. Erase button	 2. Open button	 3. Print button	 4. Undo button

  5. Magic button	 6. Slides button 

Chapter 3 – Advanced MS Paint
A.	 Choose the correct answer.

1. a	      2. b	 3. c	        4. b	     5. c
B.	 Fill in the blanks.

1. Tools	 2. Select all	 3. Click	 4. Selection
C.	 Answer of the following questions.

1.	 Color Picker tool helps us to pick a colour from the drawing.
2.	 Rotate tool is used to rotate the drawing.
3.	 The Magnifier tool is used to zoom in and out on a part of the drawing.

D.	 Distinguish between the following.
1.	 Rectangular Selection tool selects a rectangular shaped area of an image while Free-form 

selection tool selects an irregular area.
2.	 Cut & Paste moves the selection to a new location while Copy & Paste makes a copy of the 

selection.
3.	 File > New opens new file which is blank and new drawing is to be done while File > Open opens 

an existing file which may contain some drawing.
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Chapter 4 – Know Your Computer
A.	 Choose the correct answer.

1. a	 2. c	 3. d	 4. b	 5. c
B.	 Fill in the blanks.

1. ROM	 2. Hard Disk	 3. CPU	 4. Pen Drive	 5. Hardware
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. True (√)	     2. True (√)	 3. True (√)	       4. False (×)	 5. False (×)
D.	 Answer the following questions.

1.	 A computer is a machine which can do a variety of work.
2.	 Hardware and Software.
3.	 Monitor and Speaker.
4.	 Hard Disk and DVD.
5.	 A software is a set of programs.

E.	 Write down the steps for the following.
1.	 i.	 Insert the Pen drive in any of the USB ports on the system unit.
		  Open the This PC or Computer Window and click on the newly created drive. The contents of 

the drive will be displayed.
2.	 i.	 Press the DVD drive button.
	 ii.	 Put the disk in the tray.
	 iii.	 Again, press the drive button.
	 iv.	 Open the This PC or Computer Window, select DVD drive.
	 v.	 Work with files/folders.

Chapter 5 – Fun with Logo
A.	 Choose the correct answer.

1. a	 2. d	 3. c	 4. b	 5. d
B.	 Fill in the blanks.

1. Two	 2. Halt	 3. Edall	 4. RT 135	 5. FD
C.	 Write the commands for the following functions.

1. LT 90	 2. HOME	 3. CT	 4. FD 180	 5. CS
D.	 Define the following commands.

1.	 ‘Bye’ command is used to close LOGO window.
2.	 CS command is used to clear the drawing on the screen.
3.	 Home command is used to move the turtle back to the starting position.
4.	 Back command is used to move the turtle in the direction opposite to which it is pointing.
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Chapter 6 – More on MSW Logo
A.	 Choose the correct answer.

1. b	 2. a	 3. c	 4. d
B.	 Fill in the blanks.

1. FD	 2. Repeat	 3. Hexagon	 4. Triangle
C.	 Give one-line answer for the following questions.

1.	 The Repeat command is used to repeat the same set of commands.
2.	 Type Repeat 8[FD 100 RT 45] and press Enter key.
3.	 The PD command puts the turtle down and allows the turtle to draw the lines.

D.	 Write the commands to draw the following.
1.	 Repeat 360 [FD 1 RT 1].
2.	 Repeat 4 [FD 100 LT 90].
3.	 Repeat 6 [FD 100 RT 60].

Chapter 7 – Introduction to MS Word
A.	 Choose the correct answer.

1. b	 2. d	 3. a	 4. c	 5. a
B.	 Fill in the blanks.

1. Ctrl + N	    2. Status Bar	              3. Document              4. Editing	        5. Save
C.	 Answer the following questions.

1.	 MS Word is a word processing software.
2.	 Text editing refers to the process of correcting, deleting or modifying the text.
3.	 File tab, Ribbon, Title bar, Ruler, Document Area, Status Bar, View Buttons and Zoom Control.
4.	 Click on File → Open and open the required document.	

D.	 Write the steps for the following.
1.	 Click on Start button → Microsoft Word.
2.	 i. Click on a File tab → Save As option.
	 ii.	 Click on This PC or Browse a location.
	 iii.	 Give file name in Save As dialog box and click on Save button.
3.	 i.	 Place the cursor at the required location.
	 ii.	 Start typing the text.
4.	 Place the cursor at the beginning of the text and press Delete button.

E.	 Write the shortcut keys for the following.
1.	 Ctrl + N
2.	 Ctrl + A
3.	 Shift + →
4.	 Shift + ←
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Chapter 8 – Stepwise Thinking with Scratch

A.	 Choose the correct answer.
1. a	 2. b	 3. b	 4. b	 5. a

B.	 Fill in the blanks.
1. Instructions	 2. Step	 3. Motion	 4. Degrees	 5. Direction

C.	 Match the following values of point in direction block with their correct direction given 
against them:

1. Down	     2. Up	   3. Left	 4. Right

Class 4

SYLLABUS
TERM - I

1.	 Windows 10: Working with Files and Folders

2.	 Personalize Your Windows

3.	 MS PowerPoint: Basic Formatting

4.	 MS Word: Text Editing and Formatting

Term - II
5.	 MS Word: Text Enhancement

6.	 MS Word: Working with Graphics

7.	 Introduction to Internet

8.	 Programming Concepts with Scratch

9.	 Logical Thinking with Kodu

Exercises

Chapter 1 – Windows 10: Working with Files and Folders
A.	 Choose the correct answer.

1. d	 2. a	 3. c	 4. b
B.	 Fill in the blanks.

1. Secondary	 2. Ctrl+Shift+N	 3. Recycle Bin	 4. Ctrl+X	 5. Delete
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C.	 Answer the following questions.
1.	 A file is a collection of related information.
2.	 A folder is a place where a collection of files is stored.
3.	 Windows + E
4.	 F2 is used to rename a file/folder.

D.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. False (×)	 2. True (√)	 3. False (×)	 4. True (√)	 5. True (√)

E.	 Match the following.
Column-I		  Column-II
1.	 -	 b
2.	 -	 e
3.	 -	 d
4.	 -	 c
5.	 -	 a

Chapter 2 – Personalize Your Windows
A.	 Choose the correct answer.

1. b.	 2. d	 3. c	 4. b	 5. d
B.	 Fill in the blanks.

1. Operating System	 2. Transparency	 3. Screen Saver
4. Wallpaper	 5. Color intensity slider 

C.	 Answer the following questions.
1.	 The background of the desktop is called a wallpaper.
2.	 Display theme refers to the visuals & sound i.e. the desktop background window colour & screen 

saver and sound schemes on our computer.
D.	 Tick (√) the correct statement and cross (x) out the wrong one.

1. False (×)	 2. True (√)	 3. True (√)	 4. True (√)	 5. False (×)

Chapter 3 – MS PowerPoint: Basics & Formatting
A.	 Choose the correct answer.

1. a	 2. c	 3. c	 4. b
B.	 Fill in the blanks.

1. Theme	 2. Multimedia	 3. Hide background graphics	 4. Bullets	       
5. Numbering

C.	 Answer the following questions.
1.	 Preloaded designs like slide backgrounds and styles are called design themes.
	 To change a slide background: Design tab > Customize group > Format background button > 

In Format background pane select the desired settings and options such as solid color, pattern, 
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picture etc. Finally, click on Apply or Apply to All button.
2.	 When an idea or topic is presented with multimedia effects then it is called a presentation or 

electronic presentation. Examples of presentation applications are MS PowerPoint, Google 
Slides and SlideShare.

3.	 Got the desired slide > Insert tab > Text group > Text Box button > Drag on slide with mouse to 
draw the text box. 

D.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. True (√)	 2. False (×)	 3. False (×)	 4. True (√)	 5. True (√)

Chapter 4 – MS Word: Text Editing and Formatting
A.	 Choose the correct answer.

1. b	        2. b	     3. c	 4. b	 5. a
B.	 Fill in the blanks.

1. F7	 2. Bold	 3. Italic	 4. Toggle	 5. Editing
C.	 Answer the following questions.

1.	 Formatting refers to changing the text appearance; to make it attractive by charging its style, 
font, size and color.

2.	 Find and Replace tool is used to search for all the occurrence of a given text and replace an 
existing text with a new text.

3.	 Arial, Times New Roman, Cambria and Calibri.
4.	 UP arrow, DOWN arrow, LEFT arrow and RIGHT arrow.
5.	 Spelling & Grammar checking tool is used to check all the spellings and grammatical mistakes 

and rectify them.
D.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)	 2. True (√)	 3. True (√)	 4. False (×)	 5. True (√)
E.	 Match the following.

Column-I		  Column-II
1.	 -	 d
2.	 -	 e
3.	 -	 a
4.	 -	 b
5.	 -	 c

Chapter 5 – MS Word: Text Enhancement
A.	 Choose the correct answer.

1. a	 2. a	 3. d	 4. c
B.	 Fill in the blanks.

1. Left	 2. Justified	 3. Bullets & Numbering	 4. Paragraph spacing	 5. Borders



16

C.	 Answer the following questions.
1.	 Bullets & Numbering tool is used to represent the text in a listed form.
2.	 Text alignment refers to the position of the text with respect to page margins.
3.	 A watermark is a faint imprint of text or images that appear behind the text.
4.	 Line spacing refers to the vertical space between the lines of text in a paragraph.

D.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. True (√)	 2. False (×)	 3. True (√)	 4.  True (√)	 5. False (×)

E.	 Match the following.
Column-I		  Column-II
1.	 -	 c
2.	 -	 a
3.	 -	 d
4.	 -	 e
5.	 -	 b

Chapter 6 – MS Word: Working with Graphics
A.	 Choose the correct answer.

1. a	 2. b	 3. c	 4. d	 5. d
B.	 Fill in the blanks.

1. Shape Style        2. Shape Outline	 3. WordArt	 4. Shapes	 5. In Front of Text
C.	 Answer the following questions.

1.	 Lines, Rectangles, Block Arrows and Flowchart.
2.	 Adjust, Picture styles and Arrange.
3.	 A Clipart refers to apply a predefine style to a picture.
4	 i.	 Select the picture and place mouse cursor over rotating icon.
	 ii.	 Click and drag the rotation button in the required direction and release the mouse.
5.	 In Resizing, w e change the size (to make it large or shrink) an image while in cropping, we 

remove an unwanted part of an image.
D.	 Tick (√) the correct statement and cross (×) out wrong one.

1. True (√)	 2. False (×)	 3. True (√)	 4. False (×)	 5. True (√)

Chapter 7 – Introduction to Internet
A.	 Choose the correct answer.

1. a	 2. b	 3. c	 4. d	 5. b
B.	 Fill in the blanks.

1. WWW 	    2. Home Page 	 3. Google Chrome 	    4. Search Engine 	    5. Hyperlink
C.	 Answer the following questions.

1.	 A computer network is a collection of computers and other hardware devices.
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2.	 The ‘Internet’ is a network of networks.
3.	 Kiddle is a child safe search engine made by Google specially for children.
4.	 A search engine is a website which is used to search information on the World Wide Web. 

Example: Google, Bing.
D.	 Define the following terms.

1.	 It is a link that takes the user quickly to other parts of the webpage or to other webpage.
2.	 A URL is the unique address of a website that is accessible on the Internet.

E.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. False (×)	 2. True (√)	 3. False (×)	 4. False (×)	 5. True (√)

Chapter 8 – Programming Concepts with Scratch
A.	 Choose the correct answer.

1. c	 2. a	 3. c	 4. d 		  5. c
B.	 Match the blocks with their correct category.

1. d	 2. b	 3. c	 4. a
C.	 Fill in the blanks.

1. Increases	 2. Event	 3. Downward	 4. Sensing	 5. Say
D.	 Answer the following questions.

1.	 Stage shows the position and placing of sprites in our animation. Sprites are various objects that 
together make our animation.

2.	 Motion Category blocks: Move block moves the sprite by given number of steps. Glide-to block 
glides the sprite for given number of seconds to the given position of x and y coordinates.

	 Events category blocks: when key pressed block begins animation when any given key is pressed 
on the keyboard. when this sprite is clicked block runs animation when user clicks with mouse 
on the sprite to which the script is associated.

3.	 turn block turns the sprite by given degrees while point in direction block turns the sprite to 
point in the directions: up (0), down (180), right (90) or left (-90).

4.	 Checking certain condition and deciding the course of the script is called decision making like 
checking if the sprite is not moving in desired direction then changing its direction.

5.	 An event is any action occurring at any point of time before, after or during an animation for 
example, user clicks on a sprite or a key is pressed on the keyboard.

Chapter 9 – Logical Thinking with Kodu
A.	 Choose the correct answer.

1. b	 2. a	 3. d	 4. a 
B.	 Fill in the blanks.

1. Computer         2. Program	 3. New World	 4. Change settings	 5. Load World
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C.	 Identify the parts of following Kodu Game Screen.
1. Terrain	 2. Character (or Object)	 3. Play Game button	
4. Camera tool	 5. Object tool

Class 5

SYLLABUS
TERM - I

1.	 Evolution of Computers

2.	 MS PowerPoint: Views

3.	 MS PowerPoint: Graphics and Multimedia

4.	 MS Word: Layout and Views

5.	 MS Word: Working with Tables

Term - II
6.	 Introduction to MS Excel 2016

7.	 MS Excel: Working with Worksheet

8.	 Internet Searching and Surfing

9.	 Interactive Programming with Scratch

Exercises

Chapter 1 – Evolution of Computers
A.	 Choose the correct answer.

1. c	 2. c	 3. a	 4. c	 5. d
B.	 Fill in the blanks.

1. Napier’s Bones	 2. Assembly	 3. Silicon Chip	 4. Program	 5. Versatile
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)	 2. True (√)	 3. False (×)	 4. True (√)	 5. False (×)
D.	 Answer the following questions.

1. Generation of Computers refers to the time period in which the computers are being developed.
2.	 a)	 First Generation Computers Second Generation Computers

1.	 Vacuum Tubes were used.
2.	 Big in size.
3.	 They were expensive.
E.g. UNIVAC, ENIAC

1.	 Transistors were used.
2.	 Small in size.
3.	 Cheaper than first generation of computer

E.g. IBM 1401, PDP- I
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	 b)	 Third Generation Computers Fourth Generation Computers

1. IC based.
2. Smaller but not handheld.
3. Single user OS.

E.g. IBM 360, 370

1.	VLSI Microprocessor based.
2.	Small in size, handheld also.
3.	Multi-user, GUI Operating system.

E.g. IBM PC, Apple Macintosh, Compaq PC

3.	 The 3 limitations of computers are: 
	 i.	 Computers do not have self-intelligence.
	 ii.	 Computers cannot express emotions.
	 iii.	 Computers cannot replace human processes entirely.

E.	 Describe the following characteristics of computers very briefly.
i.	 Diligent: Computers can work for longer hours tirelessly. They do not get bored of repeated 

tasks. 
ii.	 Versatile: Computers can perform a variety of tasks. They execute multiple tasks at the same 

time.
iii.	 Fast: Computer’s processing speed is in million instructions per second. This speed is higher 

than the thinking speed of humans.
F.	 Briefly list 2 key features of each type of computer classified on the basis of size.

i.	 Super computer: 1. Very high storage capacity. 	 2. Data processing is ultra-fast.
ii.	 Mainframe: 1. Smaller than super computers.	 2. Large memory capacity.
iii.	 Mini: 1. Expensive and larger than micros.	 2. Mostly used as network servers.
iv.	 Micro: 1. Portable and high speed.		  2. Support different types of secondary 	

				         memories.
G.	 Match the following.

1. c	 2. d	 3. a	 4. b

Chapter 2 – MS PowerPoint: Views
A.	 Choose the correct answer.

1. a	 2. d	 3. d	 4. c	 5. d		
B.	 Fill in the blanks.

1. Normal view	 2. Outline vie	 3. Notes Page view
4. Slide sorter view	 5. Slide Master

C.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. True (√)	 2. True (√)	 3. True (√)	 4. True (√)	 5. True (√)

D.	 Answer the following questions.
1.	 Slide Master view enables us to modify slides layouts & appearance of the slide in the presentation.
2.	 Normal view, Slide Sorter view, Notes Page view, Outline view and Reading view.
3.	 Normal view displays all the slides in thumbnails in the slide pane and current slide in the slide 

area while, while Slide Sorter view sets all the slides in thumbnail form, on the screen.
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4.	 Reading view allows us to view the presentation in a full screen like Slide Show view. It includes 
the controls to flip through the slides.

Chapter 3 – MS PowerPoint: Graphics & Multimedia
A.	 Choose the correct answer.

1. c	 2. a	 3. c	 4. b	 5. d
B.	 Fill in the blanks.

1. Insert Table	 2. Chart	 3. Design	 4. Format	 5. Playback
C.	 Answer the following questions.

1.	 Table, Chart, SmartArt Graphic, Pictures, Online Pictures and Videos.
2.	 SmartArt graphic is a virtual representation of information to effectively communicate our 

messages or ideas. SmartArt graphic allows us to communicate through graphics instead of just 
text.

3.	 Icons are used to communicate visually and 3D Models are objects that move in 3D space.
	 To insert 3D Models, in Illustrations group under Insert tab, Click 3D Models respectively.

Chapter 4 – MS Word: Layout & Views
A.	 Choose the correct answer.

1. b	 2. a	 3. d	 4. d	 5. c
B.	 Fill in the blanks.

1. 1 ”	 2. Portrait	 3. Letter	 4. Read Mode	 5. Zoom In
C.	 Answer the following questions.

1.	 A page margin is a blank with space between the text and edge of the page on all the sides.
2.	 It is a text written in more than one column on the same page. For example, Two columns and 

Three columns with line.
3.	 These are links to text or picture that can provide access to a file, document or website directly 

from a page/document.
4.	 Header & Footer are the content which appear on top and bottom margin of the every page in the 

document.
5.	 A document can be viewed in Read Mode, Print Layout View, Web Layout View, Outline View and 

Draft View.
D.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)	 2. True (√)	 3. True (√)	 4. False (×)		  5. True (√)
E.	 Write the steps of the following.

1.	 i.	 Select the text and click on drop-down arrow of Columns button in Page Setup group on Page 
Layout tab.

	 ii)	 Select the Two option in the list.
2.	 i)	 Select the text that you want to put as a hyperlink.
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	 ii)	 Click on Hyperlink button in Links group on Insert tab and select the required options in the 
Insert Hyperlink dialog box.

3.	 Insert tab > Header & Footer section > Page Number> Bottom of Pages.
4.	 Insert tab > Symbol button > Symbol tab in the dialog box > Select desired Symbol > Insert 

button.

Chapter 5 – MS Word: Working with Tables
A.	 Choose the correct answer.

1. b	 2. c	 3. a
B.	 Fill in the blanks.

1.	 Alt + PageDown	 2.	 Tab
3.	 Shift + Tab	 4.	 Up Arrow
5.	 Alt + Shift + Down Arrow	 6.	 Alt + Home

C.	 Match the following.
1. b               2. c              3. a             4. e                 5. f	 6. d	

D.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. True (√)	 2. True (√)	 3. True (√)	 4. True (√)	 5. False (×)

E.	 Answer the following questions.
1.	 A table is way to represent the data in rows and columns.
2.	 a)	 Rows: Rows are horizontal series of cells in a table.
	 b)	 Columns:  Columns are vertical series of cells in a table.
	 c)	 Cell: The intersection of a row and column in a table makes a rectangular box called a cell.
3.	 Shortcut key to delete a row or a column in table is - select the required row/column and press 

Shift + Delete.
F.	 Write the steps of the following.

1.	 Select the required cells and click on Merge Cells button in Merge group on Layout tab.
2.	 i)	 Select the required cell and click on Split Cells button in Merge group on Layout tab.
	 ii)	 Enter the number of columns and rows (into which you want to split the selected cell) and 

click on OK button.
G.	 Write the shortcut key for the following.

1.	 To Move to one row down: - Down Arrow key
2.	 To select an entire table: - Alt + 5 (on numeric key, with Num Lock off)
3.	 To select a row: Go to first column of that row then Alt + Shift + End
4.	 To select a column: Go to first row of that column then Alt + Shift + Page Down

Chapter 6 – Introduction to MS Excel 2016
A.	 Choose the correct answer.

1. a	 2. c	 3. b	 4. d	 5. d
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B.	 Fill in the blanks.
1. 1048576	 2. Active Cell	 3. Formula Bar	 4. Shift + Spacebar	 5. Ctrl + Spacebar

C.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. True (√)	 2. True (√)	 3. True (√)	 4. True (√)	 5. True (√)

D.	 Answer the following questions.
1.	 i)	 In Excel, numbers and calculations are managed efficiently.
	 ii)	 In Excel, data can easily be created, analyzed and maintained.
2.	 i)	 Press Windows + R key and type ‘excel’ in the dialog box.
	 ii)	 Click on OK button.
3.	 Quick Access to olbar, Ribbon, Cell Name box, Active Cell, Formula bar, Rows, Columns, Sheet tab 

and Status bar.
4. 	 a)	 Formula Bar: Displays the data and formula stored in the cell.
	 b)	 Workbook: An Excel file is known as a workbook. It can hold many worksheets.
	 c)	 Worksheet: A worksheet is a collection of cells in the form of rows and columns.
	 d)	 Cell referencve: Cell reference is the column letter and the row number that identifies a 

single cell.
	 e)	 Active cell: The current cell on which the cursor is placed is called active cell.

E.	 Match the following.
1. e                2. d               3. b                 4. c (Ctrl + →)                5. a

Chapter 7 – MS Excel: Working with Worksheet
A.	 Choose the correct answer.

1. a	 2. d	 3. c	 4. a	 5. b
B.	 Fill in the blanks.

1. Shift cells down	 2. Entire Row	 3. Row, column	 4.12.75	 5. 255
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. True (√)	 2. True (√)	 3. True (√)	 4. False (×)	 5. True (√)	
6. False (×)

D.	 Answer the following questions.
1.	 Copying refers to duplicating the data (text, numbers and formulae in the context of MS Excel), 

while moving refers to move the data from its current location to another location.
2.	 As the name suggests, it is a tool that is used to fill a predefined series of data in adjacent cells 

quickly.
3.	 i.	 Shift cells right: It shifts existing cells to the right to make a room for the blank cells.
	 ii.	 Shift cells down: It instructs Excel to shift existing cells down.
	 iii.	 Entire row: It inserts complete row in the cell range above the selected cells (row).
	 iv.	 Entire column: It inserts complete column in the cell range to the left of the selected cells 

(column).
4.	 Undo command reverses the last action while Redo command reverses the Undo command.
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5.	 To insert a cell/row/column,
	 i.	 Select the row/column header and press Ctrl + plus (+) to insert a row/column.
	 ii.	 Select the cell, above/left to which you want to add a cell, and press Ctrl + plus (+). The Insert 

dialog box appears. Select the required option.
E.	 Match the following.

1. d	 2. a 	 3. e	 4. b	 5. c

Chapter 8 – Internet Searching and Surfing
A.	 Choose the correct answer.

1. a	 2. c	 3. b	 4. a	 5. b
B.	 Fill in the blanks.

1. Internet	 2. Web browser	 3. WWW	 4. Enter	 5. Home
C.	 Answer the following questions.

1.	 A browser is an application software which is used to open websites.
2.	 Surfing the internet is undirected type of exploration of the World Wide Web.
3.	 Online Education is a cheap and easy way to get education. It is also known as distance learning 

and consists of taking classes through the Internet.
D.	 Write a few words about the following.

1.	 Online Shopping: Using online shopping various products can be purchased.
2.	 Video Conferencing: This is the way to communicate with others on internet using web camera, 

microphone, speakers, etc.
3.	 News and Information: These are the facilities to get information about online news and other 

various topics such as science, technology, sports and education, etc.

Chapter 9 – Interactive Programming with Scratch
A.	 Choose the correct answer.

1. b	 2. c	 3. a	 4. d
B.	 Fill in the blanks.

1. Music, sound                 2. Event	 3. Instruction		  4. Control
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. True (√)	 2. True (√)	 3. False (×)	 4. False (×)	 5. True (√)	
D.	 Answer the following questions.

1.	 Sprites are the building blocks of animation. These are images that are put together and animated.
	 Blocks are used to create the script for a sprite. Each block represents an instruction. Blocks are 

placed under various categories depending on their working. 
2.	 A script is a set of Scratch blocks arranged to define how an animation shall work. Scripts are 

created by drag-dropping various blocks in the script editor. Scripts are executed by clicking 
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Execute script green flag button or through some event. For example, following script will play 
drum 4 ten times when the sprite is clicked by the user.

	

3.	 Costume editor in Scratch is used to make changes in the appearance (editing) of a sprite. (This 
has not been discussed in Class 5 that Costume Editor can also be used to create new sprites 
since it is out of the scope of class 5)

Class 6

SYLLABUS
TERM - I

1.	 Algorithm and Flowchart

2.	 Computer Languages & Programming Techniques

3.	 MS PowerPoint: Animation and Transition

4.	 Game Creation in Scratch 

5.	 MS Word: Mail Merge

Term - II
6.	 MS Excel: Formatting, Formulas and Functions

7.	 MS Excel: Working with Data

8.	 MS Excel: Presenting Data in Charts

9.	 Communication using Internet

10.	 Introduction to AI

Exercises

Chapter 1 – Algorithm and Flowchart
A.	 Choose the correct answer.

1. b	 2. b	 3. a	 4. c
B.	 Answer the following questions.

1.	 A flowchart is graphical representation of a program flow. It helps in understanding what the 
program is doing.

2.	 A flowchart easily depicts the program logic. It is easy to analyse the problem using a flowchart. 
Flowcharts help in better program documentation. Using flowcharts, errors can be identified 
and removed easily.
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3.	 A loop is used to execute instructions repeatedly as long as we need. We need to type instructions 
only once and loop takes care of their repeated execution.

4.	 Process box is used to show the calculations and processing instructions while Decision box is 
used to keep the conditional statements. 

C.	 Match the following.
1. e (arrows) 	 2. c (rectangle)	 3. d (diamond)	 4. b (parallelogram)	 5. a (capsule)

Chapter 2 –  
Computer Languages and Programming Techniques

A.	 Choose the correct answer.
1. c	 2. b	 3. b	 4. a	 5. d

B.	 Fill in the blanks.
1. Machine	 2. Compiler	 3. Variable	 4. Operands	 5. Begin

C.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. False (×)	 2. False (×)	 3. False (×)	 4. True (√)	 5. False (×)

D.	 Answer the following questions.
1.	 Machine language, Assembly language, High level language, Modern language.
2.	 A program is executable on computer while pseudocode is the logical representation of a 

program.
3.	 Data is a raw, individual piece which alone does not make any sense. Data type defines what type 

of data it is like date, number or text. A variable is a named identifier that stores the value of a 
particular data type.

4.	 NOT operator checks for the reverse of any condition. E.g. NOT (a > b) means value of variable a 
is less than or equal to the value of variable b.

5.	 Steps in planning of a program:	
	 i. Define and analyze the problem
	 ii. Develop the solution

E.	 Write Pseudocodes to do the following.
1.	 Begin
		  Accept a, b

		  Result = (a * b) / (a + b) 

		  Display Result

	 End

2.	 Begin
		  Accept Radius

		  Area = (22/7)*(Radius*Radius) 

		  Display Area

	 End
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Chapter 3 – MS PowerPoint: Animation and Transition
A.	 Choose the correct answer.

1. c	 2. a	 3. b	 4. a	 5. b
B.	 Answer the following questions.

1.	 A simulation of movement, created by displaying a series of pictures, or frames is called 
animation.

2.	 The steps to apply animation to an object are:
	 i.	 Select the object which is to be animated.
	 ii.	 On Animations tab, click on More drop-down arrow in the Animation group. Or, click on Add 

Animation button in Advanced Animation group.
	 iii.	 Select the desired effect from drop-down menu.
	 iv.	 The effect is applied to the object.
3.	 Motion Path’ is used to move the object in a specified pattern.
4.	 Slide Transition is an animation-like effects that occur in Slide Show view, when we move from 

one slide to the next during an on-screen presentation.
	 The steps to apply transition to a slide are:
	 i.	 Select the slide in the Slide Navigation pane.
	 ii.	 On Transitions tab, in Transition to This Slide group, click on More drop- down arrow. A 

drop-down menu appears.
	 iii.	 Select the desired transition to apply it to the selected slide. 
5.	 The steps to add a sound to a slide transition are:
	 i.	 Select the desired slide on which you want to add sound.
	 ii.	 On Transitions tab, in Timing group, click on Sound drop-down list box and choose a sound 

to apply it to the selected slide.
6.	 Action buttons are built-in shapes that can be used to launch an action in the presentation such 

as go to next/previous or a specified slide, play a sound/video or run a program.
7.	 The steps to add an action button on a slide are:
	 i.	 Select the slide in Slide Navigation pane.
ii.	 On Insert tab, in Illustrations group, click on Shapes command. A drop-down menu appears.
iii.	 Select the desired action button.
iv.	 Drag and draw the action button (shape) on the slide. The Action Settings dialog box appears.
v.	 In Action on click section, click on drop-down arrow of Hyperlink to: and select the required 

action. For example, click on Next Slide option.
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)	 2. False (×)	 3. True (√)	 4. True (√)	 5. True (√)
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Chapter 4 – Game Creation in Scratch
A.	 Choose the correct answer.

1. d	 2. b	 3. a	 4. a	 5. b	 6. b
B.	 Fill in the blank.

1. Animation	     2. Library	 3. Control (please change Events option in book)       
4. Variable	     5. Answer

C.	 Answer the following questions.
1.	 A block is used to create scripts. Each block is like an instruction in the script. An sprite is the 

character placed on the Scratch stage. A sprite is animated or manipulated by the help of scripts. 
2.	 To make a sprite move 100 steps, first drag-drop when this sprite is clicked event block then add 

to it the motion block move ____ steps. Set the steps’ value to 100.
3.	 if-then block executes when the given condition is true otherwise it is skipped (statements 

enclosed in it do not execute) while in if-then-else block, if part executes when the given condition 
is true otherwise the else part is executed.

4.	 Re-iteration means executing statements (blocks) repeatedly until some condition remains 
true. When that condition is not true then the re-iteration stops. Scratch provides loops such as 
forever and repeat.

5.	 A variable is the storehouse of value in Scratch. To create a variable: In Scripts tab > Variables 
Category > click Make a Variable. In the dialog box, give variable name and click OK.

Chapter 5 – MS Word: Mail Merge
A.	 Choose the correct answer.

1. a	 2. c	 3. b	 4. d	 5. d
B.	 Fill in the blanks.

1. Data Source	 2. Merge Field	 3. First Record, Last Record	
4. Sender	 5. Feed

C.	 Answer the following questions.
1.	 Mail merge tool is used to create a document for multiple recipients.
2.	 i.	 Main Document: - It is a document which has the common data that needs to be sent to 

multiple recipients.
	 ii.	 Data Source: - It contains recipients’ details that is to be merged with the main document.
	 iii.	 Merge Field: - It is the data item which is to be merged with the document from a data source.
	 iv.	 Merge Document: - This is the final document, which is obtained after merging of fields from 

data source.
3.	 Steps to insert merge fields in the document are:
	 i.	 Put cursor on the main document where you want to merge a field. On Mailings tab, in Write 

and Insert Fields section, click on Insert Merge Field button, a list of fields from selected data 
source appears.



28

	 ii.	 Click on a field to merge. Repeat this process till you merge all the fields.
4.	 Steps to merge all the data in a single document are:
	 i.	 On the Mailings tab, in Finish section, click on Finish & Merge button and select Edit Individual 

Documents option.
	 ii.	 The Merge to Printer dialog box appears. Click on OK button. This action will merge all the 

data (on the separate pages) in a single document.
5.	 Steps to view merged data are:
	 i.	 Click on Preview Result button in Preview Results section on Mailings tab.
	 ii.	 To view next or previous data click on Next Record or Previous Record buttons.

Chapter 6 – MS Excel: Formatting, Formulas and Functions
A.	 Choose the correct answer.

1. a	 2. b	 3. b	 4. d	 5. a
B.	 Fill in the blanks.

1. Format Cells	 2. Relational	 3. =	 4. Average()	 5. #N/A
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. True (√)	 2. True (√)	 3. False (×)	 4. True (√)	 5. True (√)
D.	 Answer the following questions.

1.	 Font face, Alignment, Indent, Cell Border and Font size.
2.	 Steps to format the numbers are:
	 i.	 On the Format Cells dialog box, click on Number tab.
	 ii.	 Select Number in the Category section. On the right side, several options are given to apply 

on numeric data.
	 iii.	 Select the required options and click on OK button.
3.	 - Alignment tab is used to position text and numbers in the cells, change the orientation and 

specify text control in cells.
	 - Font tab is used to set the font face, font size, font style, font color and other effects.
4.	 Steps to apply a colorful border to a cell are:
	 i.	 On the Format Cells dialog box, click on Border tab.
	 ii.	 Now, click on Color drop-down list box and select the desired colour.
5.	 A formula is an equation that performs a calculation. Like a calculator, Excel can execute formulas 

for addition, subtraction, multiplication and division.
6.	 Operators for basic mathematical operations are, (a) ‘+’ is used for addition (b) ‘–’ is used for 

subtraction
	 (c) ‘*’ is used for multiplication (d) ‘/’ is used for division (e) ‘%’ is used for percentage (f) ‘^’ 

carat for exponents.
7.	 A Function in Excel is a predefined formula that perform calculations by using specified values 

called arguments in a particular order or structure.



29

Chapter 7 – MS Excel: Working with Data
A.	 Choose the correct answer.

1. a	 2. c	 3. c	 4. b	 5. a
B.	 Fill in the blanks.

1. Relative reference	 2. Sorting	               3. Filter	
4. Conditional formatting	 5. Pivot Table

C.	 Answer the following questions.
1.	 Cell referencing is the way to identify the location of a cell in a group of cells in the worksheet. 

These cell addresses are used in formulas and functions.
2.	 Cell Referencing is of three types:
	 i.	 Relative Cell Referencing
	 ii.	 Absolute Cell Referencing
	 iii.	 Mixed Cell Referencing
3.	 Sorting data is rearranging the data. It can be done for alphabets, numbers, date and time, cell 

color, font color or icon set.
4.	 Filter tool is used for filtering data based on text, numbers, date and time, cell colour, font colour, 

etc.
D.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. True (√)	 2. True (√)	 3. False (×)	          4. False (×)

Chapter 8 – MS Excel: Presenting Data in Charts
A.	 Choose the correct answer.

1. b	 2. b	 3. d	 4. c	 5. b
B.	 Fill in the blanks.

1. Chart	 2. Bar Chart	 3. File	 4. Goal Seek	 5. F11
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. True (√)	 2. False (×)	 3. True (√)	 4. True (√)              5. False (×)
D.	 Answer the following questions.

1.	 A chart is a pictorial representation of the data i.e. it allows us to illustrate the data graphically.
2.	 Column chart shows data as vertical columns with categories on x axis and values on y axis. It 

compares the values of one or more items. 
3.	 To move a chart on the worksheet,
	 i.	 Point mouse cursor anywhere on the chart area, it converts into moving handle.
	 ii.	 Click and drag the chart to new location.
4.	 The steps to change the chart style are:
	 i.	 Select the chart on the worksheet. The Design and Format tabs appear on Ribbon.
	 ii.	 Click on Design tab.
	 iii.	 Click on the drop-down button of Chart Styles and select the required style from the menu.



30

5.	 The steps to create a chart are:
	 i.	 Select the cell range on which you want to create the chart (including column titles).
	 ii.	 On Insert tab, in Charts group, click on desired chart type.
	 iii.	 Select the chart sub-type from the drop-down list.
6.	 Insert tab > Illustrations group > Pictures tool > Locate the picture on the dialog box, select the 

picture and click Insert button on the dialog box. 

Chapter 9 – Communication Using Internet
A.	 Choose the correct answer.

1. c	 2. a	 3. d	 4. a	 5. b
B.	 Fill in the blanks.

1. Internet	 2. Forward mail	 3. E-mail a/c	 4. Yahoo mail/Gmail	 5. Compose
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)	 2. False (×)	 3. True (√)	 4. True (√) 	 5. True (√)	
6. True (√)	 7. True (√)

D.	 Answer the following questions.
1.	 Internet is a network of networks. It connects millions of computers of the world with each 

other.
2.	 E-mail is the most widely used Internet-based communication tool. It is used to send & receive 

messages through internet.
3.	 Some of Internet-based communication tools are:
	 i. E-mail		  ii. E-greetings	 iii. Blogs	  iv. E-community
	 v. Chatting/Instant messaging	 vi. Groups
4.	 ‘Chatting’ on internet is an online communication tool which allows two or more people to send 

and receive messages at the same time.

Chapter 10 – Introduction to Artificial Intelligence
A.	 Choose the correct answer.

1. c	 2. d	 3. d	 4. a	 5. d
B. 	 Match the following intelligence types with their traits.

1. b	 2. h	 3. a	 4. c	 5. g	
6. f	 7. e	 8. d 

C.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. False (×)	 2. False (×)	 3. True (√)	 4. True (√)	 5. True (√)

D.	 Answer the following questions.
1.	 Learning is a process that enhances our knowledge and intelligence. People learn in different 

ways. The term used to describe learning by machines is called machine learning.
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2.	 We see that different people are good at doing different things. Some are good in studies, some 
in sports etc. This proves that people possess combination of different intelligence types.

3.	 Intelligence comes from observing and learning about new things. Intelligence helps us in solving 
problems, making decisions and progress in life.

4.	 Various types of intelligence are verbal, logical, spatial, kinaesthetic, musical, interpersonal, 
intrapersonal and naturalistic.  

Class 7

SYLLABUS
TERM - I

1.	 Introduction to Photoshop 2021

2.	 Photoshop 2021: Advanced

3.	 Introduction to GIMP

4.	 Data Representation in Computer

5.	 Introduction to HTML

6.	 Formatting in HTML

Term – II
7.	 Lists and Images in HTML

8.	 Introduction to Cascading Style sheets

9.	 Network Concepts

10.	 Internet: E- Commerce & More

11.	 Mobile App Development

12.	 Introduction to Data Science and AI

Exercises

Chapter 1 – Introduction to Photoshop 2021
A.	 Choose the correct answer.

1.  d	 2. b	 3. b	 4. a
B.	 Fill in the blanks.

1. Option	 2. Text	 3. Rectangular marquee	 4. Tolerance or Feather 
C.	 Name the tools for the following:

1.	 Selection box in toolbox.	 2.	 Text tool
3.	 Pencil	 4.	 Magic Wand
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D.	 Answer the following questions.
1.	 i.	 Title Bar: 	 Title bar displays the title of the file in its tab. 
	 ii.	 Menu Bar: 	Menu bar contains the menus of Photoshop, such as File, Edit, Image etc.
	 iii.	 Options Bar: The Options bar shows additional Tool Options.
2.	 To add an area to the existing selection, hold down Shift key while selecting. To subtract an area 

from the existing selection, hold down Alt key while selecting. To intersect an area with the 
existing selection, Shift+Alt keys while selecting.

3.	 Magic Wand selects a region of the image by sensing similar colours depending on the Tolerence 
set for them. Magnetic Lasso senses the colour and sticks the selection outline to it as we click 
around the selection.

4.	 Various shapes can be added to the image by clicking on Shape tool. 
	 i.	 In the toolbox, select Custom Shape Tool.
	 ii.	 Select Fill colour, Stroke colour, Stroke width and desired shape from the options bar then 

draw the image.
5. 	 The span of colour selected is determined by a property called Tolerance. Higher the tolerance,  

more will be the span of the selection. Opacity determines transparency (0 means maximum 
transparent, 100 means opaque).

Chapter 2 – Photoshop 2021: Advanced
A.	 Choose the correct answer.

1. b 	 2. a	 3. a	 4. c	 5. a
B.	 Fill in the blanks.

1. Healing Brush tool	 2. Patch	 3. Clone Stamp	 4. Dodge	 5. Filters
C.	 Answer the following questions.

1.	 Retouching tools repair damaged images, apply repeated patterns, or replace colours in an 
image.

2.	 The steps to use Healing Brush tool are:
	 i.	 Select the Healing Brush tool from the toolbox.
	 ii.	 Select required options in the Options bar.
	 iii.	 Press Alt key and click on the image to define a sampling point.
	 iv.	 Drag mouse on the area where you want to use the Healing Brush tool.
3.	 The Blur tool is used to selectively blur areas of an image. The steps to use Blur tool are:
	 i.	 In the toolbox, select the Blur tool.
	 ii.	 Select required options in the Options bar.
	 iii.	 Click and drag the mouse on the image.
4.	 The steps to create a new layer are:
	 i.	 From the Layer menu, select New → Layer. The New Layer dialog box appears.
	 ii.	 In the Name text box, type the desired name.
	 iii.	 Click on OK button.
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5.	 The steps to apply a filter are:
	 i.	 Select the area and complete layer to be filtered.
	 ii.	 Click on the Filters menu and select any option.
	 iii.	 If a dialog box opens, enter values or select options and then click on OK button.

Chapter 3 – Introduction to GIMP
A.	 Choose the correct answer.

1. c	 2. b	 3. a	 4. d	 5. a
B.	 Fill in the blanks.

1. Toolbox	 2. Templates	 3. Threshold	 4. Shift	 5. Flattening
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)	 2. True (√)	 3. False (×)	 4. True (√)	 5. True (√)
D.	 Answer the following questions.

1.	 Pencil tool allows drawing smoothly. Bucket Fill tool is used to fill selected colour in the selection.
2.	 Select the Clone tool. > While pressing Ctrl key, click on the region of image you need to copy. > 

Release Ctrl key and then click in the desired region where you want to stamp (paste) the copied 
part.

3.	 Subtract selection mode removes the overlapped common area of the two selections while 
Intersect selection mode keeps selected the overlapped common area of the two selections.

4.	 Paste in place option pastes the copied part of the image in exactly the same location where the 
copied region is situated while Paste into Selection option pastes the copied part of an image 
inside and active selection.

5.	 Hide option hides the layer while it is there. Lock option keeps the layer visible but makes it 
unedited (view only).

Chapter 4 - Data Representation in Computer
A.	 Choose the correct answer.

1. b	 2. c	 3. a	 4. c
B.	 Fill in the blanks.

1. 10	 2. 15	 3. 0 with carry 1	 4. 2	 5. Decimal
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. True (√)	 2. False (×)	 3. False (×)	 4. False (×)	 5. True (√)
D.	 Write few words about the following:

1.	 i.	 Binary Coded Decimal Code
		  In this coding system 6 bits are used to represent a character. Therefore, maximum possible 

64 characters can be represented using BCD. (2n = maximum number of characters, a coding 
system can use.) 26 =2 x 2 x 2 x 2 x 2 x 2 = 64 characters.
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	 ii.	 Extended Binary Coded Decimal Interchange Code
		  This is an extended version of BCD which uses 8 binary digits to represent a single character. 

Maximum of 256 characters can be represented using this coding system.
			   28= 2 x 2 x 2 x 2 x 2 x 2 x 2 x 2 = 256
	 iii.	 American Standard Code for Information Interchange
		  This coding system is of two types: ASCII-7 and ASCII-8 to represent 128 and 256 characters 

respectively. ASCII-8 is frequently used in micro computers now-a-days.
2.	 Earlier computer coding system was not standardized in the industry that is why various coding 

systems have evolved. ASCII is the most widely accepted coding system today.
3.	 The following four major and basic operations can be performed on binary numbers: Addition, 

Multiplication, Subtraction and Division.
	 (a)	Binary Addition: Two binary numbers can be added using following rules: 0 + 0 = 0
		  1 + 0 = 1
		  0 + 1 = 1
		  1 + 1 = 0 with a carry of 1 to next higher number.
		  Example, (100101)2  + (10110) 2	 = (111011) 2
	 (b)	Binary Multiplication: Binary multiplication is done by following multiplication rules:
		  0 * 0 = 0
		  1 * 0 = 0
		  0 * 1 = 0
		  1 * 1 = 1
		  Example, (1001)2 * (10)2 = (10010)2
	 (c)	Binary Subtraction: Binary subtraction is done using following rules: 0 - 0 = 0
		  1 – 0 = 1	 (with a borrow of one from next higher number) 0 – 1 = 1
		  1 – 1 = 0
		  Note that the number from which ‘one’ is borrowed gets converted into ‘zero’ after lending a 

number.
		  Example, (10110)2 – (101)2 = (10001)2
	 (d)	Binary Division: Binary division is performed just like decimal division using following rules: 

0 ÷ 0 = 0
		  1 ÷ 0 = 0
		  0 ÷ 1 = 0
		  1 ÷ 1 = 1
		  Example, 10 ÷ 1011 = (101)2 Quotient and (01)2 remainder
4.	 Binary Number System Hexadecimal number System

1. It uses digits 0 and 1. 1. It uses digits from 0 to 15.

2. It has a base of 2. 2. It has a base of 16.
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5.	 Data is represented in computers as the presence (1) or absence (0) of electrical pulse and base 
of binary number system is 2 i.e. 1 and 0.

6.	 a.	 010001111
	 b.	 1011101
	 c.	 10101010
	 d.	 1001000
	 e.	 110000100011
	 f.	 10000001
	 g.	 1101
7.	 a.	 01001               
	 b.	 111001
	 c.	 10000000
	 d.	 0110101000110
8.	 a. 5	 b. 27	 c. 3	 d. 21 	

Chapter 5 – Introduction to HTML
A.	 Choose the correct answer.

1. b	 2. a	 3. c	 4. d	 5. a
B.	 Fill in the blanks.

1. 1991	 2. Title	 3. No Shade	 4. <center>
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)           2. False (×)	 3. True (√)	 4. False (×)	 5. True (√)
D.	 Answer the following questions.

1.	 HTML is a markup language to display web pages in web browsers.
2.	 A tag in HTML is a special keyword enclosed with angular brackets (‘<’ and ‘>’). For example, 

<html>
	 Empty Tag: In HTML, tags that have only opening tag are called empty tags. There is no closing 

tag. These tags do not act on blocks of text.
	 For example: <hr>, <br>
	 Container Tag: In HTML, tags that include both the start tag and end tag are called container tag. 

They hold or contain the text between the two tags (opening and closing).
	 For example, <body> text being formatted or defined</body>
3.	 Attributes are extra bit of information and appear inside the opening tag and their values sit 

inside quotation marks.
	 For example: <body background=“edusoft.jpg”>Margarine</body>.
	 a)	 Background, Bgcolor, Text, Left margin and Top margin.
	 b)	 Align
	 c)	 Size, Width, Align, Noshade, Color
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Chapter 6 – Formatting in HTML
A.	 Choose the correct answer.

1. b	 2. a	 3. d	 4. d	 5. a
B.	 Fill in the blanks.

1. Formatting	 2. Bold	 3. <sup>	 4. <tt>	 5. <big>
C.	 Write the use of the following tags.

1.	 The <strike> tag specifies that the enclosed text should be rendered in a strike through appearance 
i.e. the text will be displayed with strikethrough.

2.	 The <p> tag is used to define a block of text as a paragraph. The browser automatically adds 
white space before and after the paragraph.

3.	 The <font> tag is used for modifying the font type, size and colour.
4.	 Text in a <pre> tag is displayed in a fixed-width font (usually Courier), and it preserves both 

spaces and line breaks.
5.	 The <small> tag makes the text smaller. It makes text one size smaller than the default size.

D.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. True (√)	 2. True (√)	 3. False (×)	 4. True (√)	 5. False (×)

E.	 Match the following.
1. g        2. f           3. e            4. d              5. a             6. b             7. c

Chapter 7 – Lists and Images in HTML
A.	 Choose the correct answer.

1. b	 2. a	 3. c	 4. d	 5. d
B.	 Fill in the blanks.

1. <li>	 2. Src	 3. Height, Width	 4. <ol>	 5. Left, Right
C.	 Answer the following questions.

1.	 Ordered list is also known as numbered list (which uses an ordering system e.g., numbers, letters, 
etc.). By default it starts with 1.

	 E.g. <ol>	 <li>Item 1</li>	 <li>Item 1</li> 	 </ol> will display:
	 1.	 Item 1
	 2.	 Item 2 
	 While, an unordered list is a bulleted list. Unordered lists simply have a plain bullet point for 

each item in the list.
	 E.g. <ul>	 <li>Item 1</li>	 <li>Item 1</li> 	 </ul> will display:
	 l	 Item 1
	 l	 Item 2 
2.	 Definition list displays a definition term and its definition description. Definition term is 

displayed using <dt> tag and description using <dd> tag. Definition list is displayed using <dl> 
tag. For example,
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	 <dl>	 <dt>Noun</dt>	 <dd>Everything is noun</dd></dl>
3.	 In HTML, images are defined with the <img> tag. Src attribute is used with this tag to define the 

path of the image.
	 Example: <img src=”D:\images\logo.jpg”>
4.	 ‘Alt’ attribute of <img> tag specifies the alternate text, which will be displayed, if the specified 

image is unavailable due to some reasons OR until the image is uploaded on the web page.
	 Example, <img src=”D:\images\logo.jpg” alt=”Summer Sunset”>
5.	 <marquee> tag is used to set a scrolling text or image. ‘Behavior’ attribute is used to set the 

value which shows how the content should scroll. Example, <marquee behavior=”scroll”> ... </
marquee>

Chapter 8 – Introduction to Cascading Style Sheets
A.	 Choose the correct answer.

1. c	 2. d	 3. d	 4. a
B.	 Fill in the blanks.

1. Hexadecimal	 2. Font face	 3. Text-decoration	 4. Border	
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)	 2. True (√)	 3. True (√)	 4. True (√)	
D.	 Answer the following questions.

1.	 External CSS is a separate file saved with the extension .css that contains all the CSS definitions. 
Link tag is used to link the external CSS file with the HTML document. Link tag has following 
attributes whose value needs to be set:

	 rel: It takes the value stylesheet that inform the browser that a style sheet needs to be linked. 
href: It takes the name or url of the style sheet file to be linked.

	 type: It takes the mime type of the style sheet document which is a text file of extension css. 
Example:

	 The CSS file named styles.css contains following style definition:

	 .id1 {	 color:#00ff00; font-family:arial;	 }

	 HTML document:
	 	 <html>

		  <head> <link rel=”stylesheet” href=”styles.css” type=”text/css”>	</head>

		  <body>

		  <H1 class=”id1”> I am displayed in green colour and arial.</H1>

		  <p> I am plain text.</p>

		  <p class =”id1”> I am displayed in green colour and arial.</p>

		  </body>

		  </html>
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2.	 <style> #id1{
	 	 color:#00ff00; font-family:arial;

	 }

	 </style>

	 <style> #para1{

	 	 color:green;

	 	 font-family: impact;

	 }

	 </style>

3.	 External CSS is defined in a separate file so it can be attached with any HTML file in which same 
IDs and tags are used. This way, a single external css file can be used to give consistent formatting 
to multiple web pages.

Chapter 9 – Network Concepts
A.	 Choose the correct answer.

1. d	 2. d	 3. c	 4. c	 5. a
B.	 Fill in the blanks.

1. Network	       2. Computer Network	 3. Data
4. NIC card, Modem, Ethernet cable	 5. MAN

C.	 Write few words about the following:
1.	 A computer network is a system for communication among computers and other peripherals 

that are connected together to exchange information and share devices.
2.	 A Network Interface Card (NIC) is a computer hardware device designed to allow computers to 

communicate over a network.
3.	 A Local Area Network (LAN) covers a small geographic area, such as home, office or any building.
4.	 Bluetooth is a very short-range wireless technology to connect devices. It uses low powered 

frequency and can transmit data over short distance.
5.	 In the star topology, there is a hub or switch box to which all the workstations are directly 

connected.
D.	 Answer the following questions.

1.	 Modem is a device that enables a computer to transmit the data through telephone or cable 
lines.

2.	 Wi-Fi is a short range but high-speed data transfer wireless technology. It also provides wireless 
broadband Internet access to Wi-Fi enabled devices.

3.	 The network topology refers to the configuration of cables, computers, and other peripherals in 
a network.

4.	 A Metropolitan Area Network is a large network that usually spans a city, but does not extend the 
boundaries of the immediate metropolitan area.

5.	 In Client-Server network architecture there is a main computer, known as server, and other 
computers are called clients or workstations.
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Chapter 10 – Internet: E-Commerce and More
A.	 Choose the correct answer.

1. a	 2. c	 3. d	 4. c	 5. b
B.	 Fill in the blanks.

1. B2C	 2. C2C	 3. Social Network	
4. www.facebook.com	 5. E-Governance

C.	 Answer the following questions.
1.	 E-commerce refers to the purchase and sale of goods and/or services by business firms and 

consumers via electronic channels such as the Internet, without using any paper documents.
2.	 Two disadvantages of E-commerce to consumer are
	 i.	 There are chances that our product may get delayed or lost or delivered to the wrong address.
	 ii.	 With large or important orders, there is no one you can talk to face to face when we have 

questions and concerns.
3.	 Social networking service on internet is used to build social networks among people who share 

similar interests, ideas, activities, etc.
4.	 A blog is a frequently updated online personal journal or diary. Individuals can create blogs to 

share their expertise on specific topics with the world.
5.	 A videoconferencing is a live connection between people in separate locations for the purpose of 

two-way communication by using computer networks.
	 The students of remote locations can take benefits of E-learning services in their studies via the 

Internet, intranet/extranet and satellite TV.
6.	 Differences between traditional banking and E-banking are,
	 Traditional banking E-Banking

1. Funds are transferred through ex-
change of cash, cheques.

1. Funds are transferred through an exchange 
of electronic signals (via Internet) between 
financial institutions.

2. Signature on a cheque is the only
way to withdraw cash from account.

2. Customer/Personal Identification Number
is the only way to access bank account.

D.	 Match the following.
1. g	 2. a	 3. f 	 4. b	 5. c	 6. d	 7. e

Chapter 11 – Mobile App Development
A.	 Choose the correct answer.

1. a	 2. a	 3. d	 4. c	 5. c
B.	 Fill in the blanks.

1. Types	 2. B2B	 3. Installation	 4. MIT	 5. Viewer
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C.	 Answer the following questions.
1.	 Five features/benefits of Apps:
	 i.	 Apps are a great way for businesses to reach their customers.
	 ii.	 Apps help businesses provide their customers quick and better services.
	 iii.	 Apps are quicker way to address customer grievances.
	 iv.	 Apps are a reliable way to carry out transactions since they are provided by the service 

provider and the responsibility of secured transactions lies with the business.
	 v.	 Apps are provided as an option. Users are still free to access web services
2.	 Hybrid apps have features of both Native and Web apps. They provide certain features of the app 

even if device is offline. They are integrated with mobile operating system and web services also. 
They store some content locally on the device. These apps provide popular cloud services. 

3.	 Gaming apps: Angry Birds Go, Candy Crush Saga.
	 Entertainment apps: Netflix, Hippo magic.
	 Business apps: Amazon, OLX.
	 Please remove Lifestyle category from the question.
4.	 The steps to install an app on mobile device are:
	 i.	 Open Google Play Store App. You can also go to play.google.com.
	 ii.	 Search the desired app by typing its full or partial name in search bar at the top or browse 

for the app in various categories.
	 iii.	 Select the app once it is found by touching its icon on the mobile device screen.
		  It will display the features, rating and reviews of the app along with the button Install.
	 iv.	 Touch on Install button. App will begin downloading showing the download 		

progress bar and after a short while it will install.
5.	 Designer allows creating the graphical layout of the app while Blocks part provides various 

programming blocks to add interactivity to the app.

Chapter 12 – Introduction to Data Science and AI
A.	 Choose the correct answer.

1. b	 2. d	 3. b	 4. c	 5. c
B.	 Fill in the blanks.

1. Data	 2. Human brain	 3. Analysis	 4. Analytics	
5. Supervised	 6. Reinforced

C.	 Categorise into structured, semi-structured and unstructured data.
Structured: 2, 6		  Semi-structured: 1, 4			 
Unstructured: 3, 5

D.	 Match the following terms with their correct explanation/definition.
1. c	 2. b	 3. e	 4. a	 5. d

E.	 Answer the following questions.
1.	 Describing life events in the form of data is called datification. Deriving useful conclusions from 
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data is called data science, artificial intelligence is the field to develop machines that exhibit 
human-like intelligence.

2.	 Tables and data collected from forms is structured data, CSV files, XML files, QR codes are semi-
structured data and search results, chat data and online posts are unstructured data.

3.	 Data science helps in deriving useful conclusions from vast amount of data. Data science helps 
in revealing unseen problems by analysing data. With the help of data science, we can deal with 
social and economic problems more effectively.

4.	 The volume of data available online from numerous sources is very huge in size. It is being created 
constantly, adding to the size every passing moment. Most of the data is not in structured format. 
This data exists in various of data types such as images, video, audio, text etc. So, huge volume, 
unstructured format and variety of data types makes it difficult to be processed by traditional 
computers. It needs advanced, fast computers.

5.	  Techniques of data science help in preparing the training and testing data suitable for the desired 
AI algorithm. Acquiring the data, cleaning it, exploring it and preparing it for AI algorithm is 
done using data science. Then, the process of training the AI algorithm with training data and 
testing its performance using testing data is done.

Class 8

SYLLABUS
TERM - I

1.	 Database Management System

2.	 Working with MS Access

3.	 Table, Hyperlinks and Forms in HTML

4.	 Creating Interactive Webpages

Term - II
5.	 Introduction to Flash CS6

6.	 Flash CS6: Advanced Features

7.	 Introduction to Data Science

8.	 Artificial Intelligence

9.	 Computer Ethics and Crimes

10.	 A Tryst with Python

Exercises

Chapter 1 – Database Management System
A.	 Choose the correct answer.

1. a	 2. c	 3. b	 4. d	 5. c	
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B.	 Fill in the blanks.
1. Data                    2. .accdb, .mdb                 3. Files             4. Fields	 5. Field

C.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. True (√)	 2. True (√)	 3. False (×)	 4. True (√)	 5. False (×)		
6. False (×)

D.	 Answer the following questions.
1.	 Data is a raw piece of information which alone does not make sense. Relating data pieces together 

logically gives useful information.
2.	 DBMS is an application software that enables users to create, maintain database and control all 

the access to the data. DBMS is efficient from file systems in managing the information and to 
integrate them with other programs and applications. Data can be kept secured in a DBMS.

3.	 Table stores the data in an organized fashion while query is a tool to extract data from the tables.
4.	 Primary key uniquely identifies each record in the table.
5.	 A foreign key is a referential constraint between two tables. The foreign key refers to a value in 

another table (child) that refers to a matching value in parent table. For example,
	 Table: PERFORMANCE

Admission_Number EXAM MARKS
ADM000000003 Term 1 76
ADM000000001 Term 2 84
ADM000000002 Term 1 83
ADM000000002 Term 2 89
ADM000000003 Term 2 78
ADM000000001 Term 1 93

Table: STUDENT
Admission_

Number
Student_Name

ADM000000001 Ravi Kumar
ADM000000002 Anu Sharma
ADM000000003 Rehman Siddiqui

	 Here, in table STUDENT, ADMISSION_NUMBER is Primary key while in table PERFORMANCE, it 
is foreign key. (Every value has a matching value in the parent table).

6.	 Below are the data types in MS-Access:
	

Chapter 2 – Working with MS Access
A.	 Choose the correct answer.

1. d	 2. c	 3. b	 4. d	 5. d
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B.	 Fill in the blanks.
1. Numeric	 2. One	 3. Sort A to Z	 4. * (asterisk)	 5. Relationship

C.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. True (√)	 2. False (×)	 3. True (√)	 4. True (√)	 5. False (×)

D.	 Answer the following questions.
1.	 Sorting means displaying or arranging the data in a sequential order (ascending or descending) 

while filtering means displaying data on the basis of some filter criteria.
2.	 The 3 types of relationship in a database are one-to-one, many-to-many and one-to-many.
3.	 Referential integrity means to ensure that correct data is stored in the tables. This is done by 

applying referential integrity rules to check if matching values are present or not.
4.	 There are multiple tables in a database that store data about various items, topics and events. 

To extract complete information from the database two or more tables need to be related with 
each other on the basis of common fields. For example, to extract the details of items sold in a 
particular month, tables ITEM and SALES need to be related on the basis of common field ITEM_
CODE. 

Chapter 3 – Tables, Hyperlinks and Forms in HTML

A.	 Choose the correct answer.
1. d	 2. a	  3. a	 4. b

B.	 Fill in the blanks.
1. Body	 2. Cellspacing	 3. Colspan	 4. Internal	 5. Forms

C.	 Tick (√) the correct statement and cross (×) out the wrong one.
1. False (×)	 2. True (√)	 3. False (×)	 4. True (√)	 5. False (×)

D.	 Answer the following questions.
1.	 Rowspan attribute is used to merge two or more rows.
2.	 Radio button is used to accept one of multiple choices from user in a form. It is created by setting 

type property of input tag to radio. Check boxes are used to accept multiple selections from the 
user in a form. They are created by setting type property of input tag to checkbox.

3.	 An HTML form is a section of a document containing normal content, markup, special elements 
called controls (checkboxes, radio buttons, menus, etc.), to get inputs from the user.

4.	 Textbox Textarea
1. Textbox is a single line text field that al-
lows the user to input text.

1. Textarea is a multiple-lines text input 
control.

2. A Textbox can be created using <input> 
element with attribute text.

2. A Textarea can be created using
<textarea> element.
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Chapter 4 – Creating Interactive Webpages
A.	 Choose the correct answer.

1. c	 2. d	 3. a	 4. c	 5. a
B.	 Fill in the blanks.

1. ID	 2. Onchange	 3. . (dot)	 4. Function	 5. concatenation
C.	 Answer the following questions.

1.	 parseInt() converts string to numeric value. E.g. var x = parseInt(“45”) toString() converts 
numeric value to string.

	 E.g. var x = 1000 var b = x.toString()
2.	 Event is any interrupt that occurs due to user action or application like, mouse click. Event 

handler is the function that executes in response to an event. E.g.
	 <script language=“javascript”> function greet()
	 {
		  alert(“Greetings”)
	 }
	 </script>

	 <font onclick=“greet()”>Click me to welcome you.</font>

3.	 / is division operator, % is modulo operator and ++ is increment operator. E.g.
	 var x = 10 / 3 will return 3 in variable x. var x = 10 % 3 will return 1 in variable x. var x = 10
	 x++ will make the value of variable x 11.
4.	 onMouseEnter: When mouse pointer comes over an object like button, text etc. onMouseOut: 

Reverse of onMouseEnter i.e. when mouse goes away from an object.
	 <H1 ID=para1 onmouseenter=”f1()” onmouseout=”f2()”>Click me for 

magic.</H1>
	 <script language=“javascript”> function f1()
	 {
		  para1.color=”red”
	 }
	 function f2()
	 {
		  mytext.color=”#000000”
	 }
	 </script>

5.	 InnerHTML property refers to the area between the start and end tag of any container element. 
E.g. mytext.innerHTML=“Here comes the text.”

	 mytext is the ID of any HTML container element such as font.
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Chapter 5 – Introduction to Flash CS6
A.	 Choose the correct answer.

1. b	 2. d	 3. d	 4. d	 5. d
B.	 Fill in the blanks.

1. Panels	 2. Layers	 3. Keyframes	 4. Ink bottle	 5. 12
C.	 Answer the following questions.

1.	 Flash is used to create interactive and animated vector graphics for the web as well as for desktop 
presentations, movies, games, etc.

2.	 The Sub selection tool is the companion for the pen. It either moves or edits individual anchor 
points and tangents.

3.	 The Timeline is the area where we organize and control time-based animation in Flash. Flash 
documents divide lengths of time into frames.

4.	 Layers are used to determine which elements appear in the foreground and which appear in the 
background, creating a visual stacking order for objects on the Stage.

	 To be identified, each layer should be given a unique name in an animation.
5.	 In the timeline, click on the layer and drag it up or down to bring where you require it and 

release mouse button.
6.	 Frames refer to the still images that when shown sequentially, create the illusion of animation.
7.	 Keyframes are the drawings which define a movement. The keyframes represent the starting 

and ending points for tweens.

Chapter 6 – Flash CS6: Advanced Features
A.	 Choose the correct answer.

1. c	 2. b	 3. c	 4. d	 5. a
B.	 Fill in the blanks.

1. Morphing	 2. Instance	 3. Shape tween	 4. Sound	 5. WAV
D.	 Answer the following questions.

1.	 Shape tween is used to create a morph effect. Morphing is an animation style that describes one 
shape turning into another shape. In shape tween, the user only needs to define the first and the 
last frame

2.	 Click on the required layer and drag with mouse until you bring it to the desired sequence 
number and then release the mouse button.

3.	 Sound makes the animation lively. It is the soul of animation. The steps to add sound are:
	 File menu > Import submenu > Import to Library option. In the dialog box, locate your sound file, 

select it and click Open button. Sound will be added to Windows menu > Library option.
4.	 1.	 Select the Insert menu → New Symbol. The Create New Symbol dialog box opens.
	 2.	 Type [Text] in the Name: text box.
	 3.	 Click the Graphic option button in the Type: section.
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	 4.	 Click OK button. The symbol definition scene opens.
	 5.	 Using the Text Tool (T) add some text in the first frame (see figure 18). Format the text as 

required.
	 6.	 Click the Scene 1 button on the timeline to go back to Scene 1.
	 7.	 Add the newly created symbol to top-left corner of the stage in frame 1 by left-clicking and 	

dragging it from the Library panel.
	 8.	 Insert a new keyframe in frame 24.
	 9.	 With the Selection Tool (V), move the text to middle of the stage in frame 24.
	 10.	Enlarge the text in frame 24 using Free Transform tool
	 11.	Left-click in frame 1 on the timeline.
	 12.	Select Classic Tween from Insert menu.

Chapter 7 – Introduction to Data Science
A.	 Choose the correct answer.

1. b	 2. b	 3. d	 4. a	 5. c
B.	 Fill in the blanks.

1. Digital, Numbers	 2. E-Commerce	 3. Diagnosis	 4. IoT
C.	 Match the following applications with their correct field/area.

1. d	 2. a	 3. e	 4. b	 5. c
D.	 Answer the following questions.

1. Describing objects, people and events in the form of data is called datification. Science of 
discovering useful knowledge by analysing the data is called data science.

2.	 Dynamically generated, complex form of immense data is called big data. Its common sources 
are websites, social media, online transactions etc.

3.	 The 3 benefits of data science are – unlocking hidden intelligence, precise predictions and 
answering the unanswered questions.

	 Unlocking hidden intelligence: Data science helps in discovering trends and patterns in the 
complex data which are not easy for human mind to find.

	 Precision and speed: Real life businesses need answer to their question correctly and in time to 
make important decisions. Data science techniques make it possible by analysing immense data.

4.	 Five applications of data science are:
	 i.	 Predicting customer behaviour.
	 ii.	 Analysing people’s preferences and sentiments on social media.
	 iii.	 Disease prediction and diagnosis.
	 iv.	 Predicting possible threats and challenges in various industries.
	 v.	 Fraud detection and risk analysis in finance.
5.	 Search Engine Optimisation is the technique to make a website appear on top in the search 

results returned by a search engine. Data science tools help in achieving this by mapping the 
keywords with the search words types by the user.
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Chapter 8 – Artificial Intelligence
A. 	 Choose the correct answer.

1. c	 2. b	 3. d	 4. c
B.	 Fill in the blanks.

1. Habits	 2. Reason	 3. Machine	 4. Inductive	 5. Deep Learning
C.	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)	 2. True (√)	 3. True (√)	 4. True (√)
D. 	 Answer the following questions.

1.	 Human brain first senses the incoming stimulus. For example, feeling hot. Reasoning means 
analysis the stimulus and reach a suitable conclusion. For example, feeling hot is sensing and 
deciding not to go closer to the fire is reasoning.

2. 	 The 5 traits of human intelligence are perception, learning, problem solving, reasoning and 
language.

3. 	 The 3 applications of machine learning are predicting weather conditions, image recognition 
and expert systems in fields like medical and education.

Chapter 9 – Computer Ethics and Crimes
A. 	 Choose the correct answer.

1. a	 2. c	 3. d	 4. b	 5. a
B. 	 Fill in the blanks.

1. Virus                 2. Firewall	 3. Spyware	          4. Phishing		
C. 	 Tick (√) the correct statement and cross (×) out the wrong one.

1. False (×)	 2. True (√)	 3. False (×)	 4. True (√)	
D. 	 Answer the following questions.

1.	 Trojan is a program promoted as useful program but once installed it harms the computer. A 
Worm slows down the computer and replicates itself from one computer to other over a network.

2.	 Phishing: Fraudulently acquiring sensitive information from the users by impersonating trusted 
websites like banks and e-commerce merchants etc. is called Phishing. Phishers target the details 
like pins, passwords and answers to security questions. Phishing occurs generally in the form of 
an email or through a legitimate sounding phone call.

	 Pharming: When website’s traffic is redirected to another unauthorized fake URL then it is 
called pharming. Hackers somehow get access to the website’s servers and manipulate the 
configuration files which identify the server as host website on Internet.

	 Protection: Install anti-phishing software.
	 Never give away any sensitive information related to finance and security like pins, passwords, 

bank balance, transaction details, identification numbers etc. in reply to undesired emails and 
never on phone.
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3.	 Children must know that their parents and teachers are always available for them when they 
face such problem.

	 Children must know that no matters what, parents and teachers are their first support. Children 
should inform their elders about any incident that sounds nasty even remotely.

	 Children must know the fact that cyber bullies are not capable to do any harm and they can 
never carry out their claims of harming someone.

	 Children are advised to block such intruders immediately and never entertain them.
4. 	 A firewall is a security combination of hardware and software that is used to protect a server and 

network resources from unauthorized access and intrusion. Firewall checks the incoming data 
packets over the networks and filters out which do not have suitable and sufficient permission 
to access the network. This way an extra level of protection is created right at the gates of the 
network.

Chapter 10 – A Tryst with Python
A. 	 Choose the correct answer.

1. c	 2. a	 3. d	 4. c	 5. c		  6. b
B. 	 Fill in the blanks.

1. 1	 2. 0	 3. Script	 4. #	 5. len()
C. 	 Tick (√) the correct statement and cross (×) out the wrong one.

1. True (√)	 2. False (×)	 3. False (×)	 4. True (√)	 5. True (√)
D. 	 Answer the following questions.

1.	 The 3 features of Python are:
	 i.	 Python is an open source programming language.
	 ii.	 Python is easy to learn.
	 iii.	 Python’s programming library makes programming easier and quick.
2.	 Interactive mode allows user to issue one command at a time on the command prompt >>>. 

The commands issued in interactive mode are not saved for later use. In Script mode, the logical 
sequence of instructions called scripts are saved as .py files which can be executed anytime 
required.

3.	 A variable is a named identifier of data in a script. The data used by the script as input, processing 
and output is stored in a variable. Variables have unique names in the script and their values 
may change during script execution hence the name variable.

4.	 Comparison operators compare two values and return true or false accordingly. For example, 
< operator compares for less than such as a<10. Here, it will return true for all the values of a 
which are less than 10 otherwise false. Another example is != which checks if two values are 
different such as a!=5 will always return true if variable a has any value which is not 5. If a has 5 
then it will return false.


